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“Insist on yourself. Never imitate.”

Ralph Waldo Emerson



Introduction
It is time to talk about photo's and any other graphical elements you might need on your store or  
your satellite site. Many of the following chapters require you to use images, mainly photo's. Here 
we will cover how to take them, buy them, modify/resize them and very important for the web 
make them quick loading. Before we go any further get yourself a free copy of the photo editing 
software used in  this  chapter.  Download GIMP from  www.businessdreams.net.  Click on 
Resources,  then  Required  software.  Scroll  down  to  GIMP and  click  download GIMP. 
Double click on the downloaded file to install.

How to get photo's
This section will show you how to obtain the images you need. It will also teach a few simple skills 
that  are  commonly required  to  make the  image suitable  for  your  web site,  using the  software 
provided. Feel free to play around with the techniques. The actual application of these skills will 
come to light in the individual sections where they are required.

There are many types of photo's you might need. Obviously if you can take the picture yourself it 
will mean you don't have to invest in buying somebody else's pictures. Now if you need something 
fancy like for example the picture in this manual used for the 'Getting started' or 'Checkouts, backup 
and security' then you are almost certainly going to have to buy them. The skills and equipment 
needed for this type of image are way beyond the scope of this manual.

The good news is that I will show you a couple of places to get such images at very reasonable 
prices and that the most common pictures you will need (the items you sell) can almost certainly be 
obtained/taken for free. 



Taking and borrowing product photo's
Before you go to the cupboard and get the camera out, can you get the pictures free from someone 
else? First a word of warning. Never pinch them from a competitor if they find out they could take 
legal action. However the manufacturer or wholesaler will (usually) be more than happy for you to 
use and amend their pictures. Get permission first then go to their site and copy what you need. This 
is  easy.  Right click an image and select save as (or  similar  depending upon your  choice of 
browser) and save them to your PC. You can then begin editing them. The other advantage of doing 
it this way is you don't need to purchase the actual items of stock yet. If you do end up having to 
buy some or all of the products get the smallest quantity possible. I purchased products in single 
quantities from a regular shop when I got started. This avoided investing in a bulk order from the 
wholesaler until I was ready. 

Taking photos is not hard. All you need is a basic quality digital camera. The size of image used in 
most stores on the internet is quite small. So if you can take a reasonable quality full size photo, by 
the time we have shrunk, edited, optimised and used a few effects any minor blemishes will be 
invisible. Here are a few tips for getting a decent quality starting image to work with.

Digital cameras need much more light than a film camera. Where possible take your pictures 
outside in good light. It doesn't necessarily have to be bright sunlight but not dawn or dusk. The best 
type of light is ambient. Don't put the subject in direct light. In summer I wait until the sun is at the 
front of the house and then go into the back garden.

Create a neutral background if possible. When you come to make changes to your pictures if 
there is detail or scenery in the background then this is much harder and getting rid of a background 
using software is a pain. For small boxes and bottled products I uses plain white A4 paper as a 
background. Either place the paper on the floor and/or make a background with one or more pieces. 
The fact you have used this technique will not be evident after editing.

Take multiple pictures of the same product. Your first picture will rarely be good enough. Take at 
least 20 or 30 shots of your product from different angles, lying down, standing up, zoomed to a 
particular point of interest, different distances away etc. Try doing some really close shots using the 
macro feature, usually available on even cheap cameras. It is usually represented by a small flower 
icon. Make sure you get a green focus light at the same time.

Take the product as you would see it on the shelf/peg etc. What I mean by this is if for example 
the teddy bear comes in a presentation box then this is how you you should present it to your  
customer (initially).  It  is  true that  the customer might  also want  a  close up of the eyes  or the 
fluffiness of the fur, but the main, most important shot should be of the product as it would be on  
the  store  shelf.  This  is  the  format  the  most  successful  retailers  use.  We will  cover  alternative 
pictures and how to use them, when we cover optimising sales and visitors in a later chapter.

Buying photo's
The best two sources in my opinion are istockphoto.com and dreamstime.com. They are 



both great sources and have no minimum orders. Both require you to place $10 (£7 approx at time 
of writing) on your account. You can then buy pictures until that runs out.

They  do  have  some  differences  however.  Generally  speaking  istockphoto  has  a  much  bigger 
selection and plainly, on some searches, a higher quality. Dreamstime however is usually half the 
price or less and is always worth checking, because although not as extensive as their competitor,  
still  often  has  a  wide selection  depending of  course  on what  your  search criteria  are.  I  would 
estimate  75%  of  my  pictures  that  I  had  to  purchase  came  from  Dreamstime  and  25%  from 
iStockPhoto.

I recommend you sign up with both of them now. Don't deposit any money yet, but experiment with 
their search facilities. Try searching for your product keywords, terms from your industry, specific 
product type and even some more general terms like sale, quality, store etc. You will start to get a 
good idea of what is available.

Don't be tempted to buy loads of images now. Wait  until we discuss specific requirements and 
attributes that will be required in the coming chapters.

It is most likely you might use a purchased picture for category pages and perhaps the header for 
your  store.  Where  as  you  will  most  likely use photo's  you  took  yourself  or  borrowed for  the 
products themselves.

Editing photo's
Now you you know how to get the pictures you will  need, here is a range of ways to use the 
provided software to create professional looking images for your store. There is the full  GIMP 
manual on www.businessdreams.net. Click on Resources and then on Manuals. You can 
save it to your computer or view it online. It has more extensive help and instructions. Here are the 
most common tools that you will probably use.

Basic editing tools
Here is an introduction to the most used tools on Gimp. Overleaf is a picture of the Gimp tool 
selector. I have numbered some of the commonly used tools.
 

1) You can drag a rectangular region to select a rectangular region with which to perform 
another operation.

2) Zoom in and out of your image to see more detail or a better overview.
3) Move or select an individual part (called a layer) of your image.
4) Create text on your image (more later).
5) Fill an entire area selected by tool 1 with a colour.
6) A pencil or a brush for freehand drawing on your image.
7) A rubber for rubbing out.



Pictures and graphics - The Gimp tool selector

I  find  one of  the most  useful  tools  is  the  undo key combination.  This  is  the  same as  in  most 
Windows applications. If you make a mistake simply press and hold ctrl then press Z for each stage 
you wish to undo. This is much easier than rubbing things out.

Copying & Pasting
On many occasions you might want to combine 2 or more images. Open both images. Click on the 
image you wish to add to another and press and hold ctrl then press C. Now select the image you 
wish to paste to and press and hold ctrl then press V. You can now do all sorts of things with this 
extra 'layer' read on for some ideas.

Resizing
To resize your current selection select Image > Scale Image. Usually the best way to change an 
images size is to change either the width(x) or height(y) value and not both. The reason for this is 
that if the values are not kept at the same ratio you will distort the image. If you change just one  
then Gimp automatically changes the other to keep it at the same ratio. 

Cropping
If you want to chop out a selection from an image then use the select (as described earlier) tool to 
choose the area you want to KEEP. Then select Image > Crop To Selection. Whoosh it's gone.



Special effects
Gimp has loads of these to enhance your images. Select Filters from the main menu and you will 
see about a dozen options, most with sub options to perform weird and wonderful effects on your 
image. Play with them to find what you want. Remember you can undo any effects you don't like 
simply by holding ctrl and pressing z once.

Optimisation
This is an important topic because it deals with making your image as small a file size as possible  
so your web site loads quickly and efficiently for your customers. Generally speaking you will want 
to save your images as .jpg format. This can be done simply by selecting File > Save As when you 
have your finished image. Type the name and add .jpg at the end.

First  however make sure your image is  the optimum width and height.  If  your picture will  be 
displayed at 200 pixels wide and 200 high make sure the actual size is that also. Otherwise the web 
browser might show a nice neat 200 x 200 picture but the customer has to download the full size 
image first. So look back at Cropping and Resizing if necessary.

Now you need to experiment with the level of compression. When you save a file as .jpg you will 
be offered a box to select a number between 1 and 100. 100 is a perfect copy of your image with no 
compression. 1 would be an image distorted to complete unsuitability. You need to experiment to 
find the lowest number and therefore the smallest file size possible, where you still think the image 
is the quality you want for your site.

Text on images
This section is after the discussion on optimisation because text does not optimise well. Generally 
speaking optimise the final result then stick the text on as described here.

I have already indicated the text tool in the previous image number 4. Click on it and then click 
approximately where you want your text to appear. Note on the main Gimp toolbar while typing 
text you can also change the font size, colour and style. Click close when you have typed your text 
and select the move tool (number 3) to move it exactly in to position.

Gimp Summary
You might have noticed that this photo editing package is huge. The options are in their thousands. I 
have tried to give a really quick and hopefully useful summary to get you adding images to your site 
asap. Well aware that there is more to GIMP than I could possibly cover. So be sure to check out the 
GIMP manual mentioned earlier.



Software and book images
If you have opted for selling self published books, re-branded software or CD/DVD's produced by 
yourself  then  presentation  is  everything.  When  the  physical  product  is  of  little  or  no  physical 
substance it is even more important to graphically represent your items in a manner that adds value.

You can do this by designing a cover for your book or disc in Gimp and then  using the GIMP 
perspective tool to add depth to the image. Then go buy yourself a nice smart 3d book/disc image 
from www.Istockphoto.com or www.dreamstime.com and superimpose your cover to the 
purchased 3d image. That's the cost cutting way of doing it.

If on the other hand you wanted your images to look exceptionally good you could use professional 
software instead. If you like the look of the images on  www.businessdreams.net then you 
will want to get your hands on a copy of Box Shot 3d. 

This unlike most of my other recommendations is NOT free. However the quality and variety of 
images available is second to none and the cost is only around $60 at time of printing. 

The ease of use is also superb. You can create books in many types and arrangements as well as CD, 
DVD, Blu-Ray, leaflets and you can even import models downloaded from the Internet for free. I 
am currently working on a Business Dreams Apache helicopter!? No use whatsoever, but a lot of 
fun. 

You can download a free trial at  www.boxshot3d.com and if you like it just pay your money 
and enter the license code.  As you know I rarely suggest opening your wallet  but if  you want 
stunning 3d product images this could be one time to spend a little bit. 

Branding & Logos.
Like many of the topics in this book, branding and logos could easily have taken up a whole book 
on its own about the various aspects of marketing. Any good book covering the subject of branding 
would certainly also discuss other aspects of marketing before any web site was started. 

The problem with considering the branding of an entire web site is that if you manage to come up 
with a cool brand you then have to get the web site specifically designed. Then because the web site 
is unique, 9 times out of 10 the open source – free software solutions will almost certainly become 
unusable. So immediately the cost of getting your business off the ground has soared. Certainly into 
the thousands. Now, perhaps surprisingly, this is not the main reason why I advise against getting a 
professional to do your branding and site building.

Once you have a bespoke business you have ongoing bespoke requirements. If you want to change 
something or add a graphic etc, almost certainly the professional will have to do it for you. Worse 
still  they will  probably insist  you  host  your  web site  with  them,  again,  almost  certainly at  an  



exorbitant monthly fee.

Now there is no harm in commissioning a professional to do just a logo or perhaps a logo with site 
header because the expense would be a one off. You would not be tied to that person for any other 
aspect of your business. You could then use there professional design and colour scheme throughout 
the development of the rest of your business. I am going to assume you want to do everything 
yourself and talk to you about designing a logo and thinking about colours. Then when you come to 
making your web site header graphic later you will already have a logo and some colour scheme 
ideas.

If you do want to contract out logo or header design, try this website: 

www.elance.com

You can receive ideas and bids for your work from independent professionals with no obligation. I 
almost succumbed to the temptation of using Elance to design the cover to this book. Some of you 
might think I should have succumbed!? 

Anyway on with the show.

Discovering theme and colours
Think about some specifics of your business to help you. 

● What is the name of your product/service/business?
● Do you have a catch phrase/slogan/unique aspect to your business?
● Do you already have some colour schemes in mind?
● Is there a specific message you want your logo/brand to put across?
● What else is important about your business?

Now we need to find ideas and examples to inspire your possible choices. There are 3 sources I  
always use when looking for inspiration.

My competitors. Do they have colourful, flamboyant logos and themes? What colours do they use? 
Do they use a graphic for the logo or just text? If they use text what fonts, colours and sizes do they  
use. Do I like there designs?

Google Image Search. Here is a wealth of ideas. Go to Google. Click on 'image search' in the top 
left and type words and phrases related to your business/products/services. Vary the search phrases 
including adding words like style, logo, and brand on to the end. You will find many images, colour  
schemes and web sites to inspire your choice. Obviously don't just pinch someone's logo off of 
Google. Instead start to build up a colour scheme, style and logo in your mind.



Stock  image  web  sites.  My  favourites  I  have  already  mentioned  are  istockphoto.com  and 
dreamstime.com  but  there  are  loads  more.  Just  google  for  'stock  images'  and  you  will  be 
overwhelmed with choice.  Do similar searches to that which you did on Google. Remember to 
repeat searches with the extra words (brand, logo, theme) on the end.

Implementing your logo and brand
Open up Gimp.  And as explained previously use the text tool  to type your company name,  or 
whatever  words  are  going  to  be  part  of  your  logo.  What  fonts  do  your  competitors  use?  Try 
changing to those or similar. Experiment with different sizes and styles for different parts of your 
text.

Did you discover a great idea for font colour while doing your research? No? Go and have another 
look. Try changing the font colours. Did you find any cool images or ready made logos on any of 
the stock picture web sites. Pinch the graphic and experiment with it. You only need to buy it if you  
decide to actually use it. Don't go buying up loads of  images just to experiment with.

Don't spend too long at this stage. The reason for this is that the size and shape requirements will 
vary depending upon which store software you have decided to use. Specific instructions about size 
etc. are contained within the relevant upcoming sections.

Hopefully by now you are starting to get a feel for what you like and the colours that work well 
together and are appropriate for your business. By appropriate I mean that if your business is a 
'serious' one. Perhaps you offer some kind of bereavement counselling don't use a fun font like 
'balloonist'.

Coping With Loss.com

At the end of the day if branding and logos are causing you a problem, don't worry. Just keep it 
really  simple.  Put  your  company/web  site  name in  an  appropriate  font  and colour  on  a  white 
background. With perhaps your slogan inset in a smaller font underneath. Many really big names 
have very simple brands. Look at google. All white with a nice smart Google in the middle. That's 
it.

As you progress with your business you will come across opportunities to impose a bit more of your 
brand.  The obvious example is  when we put  the header  on your  web site.  But  there are  other 
opportunities as well like when you learn how to add graphics, products and articles. Later chapters 
also discuss changing background colours etc.



The ultimate opportunity to impose your business brand will come near the end of the book when 
we talk about how to find and choose an entirely new template at very little or no cost. At that  stage 
it will  be worth having a really solid idea about your brand so you can find the perfect template to 
use to make your business and web site unique to you.

For now keep it simple or make it flamboyant, whatever suits you best. Remember that by building 
your  site  from scratch  you  have  complete  flexibility  to  change,  update  or  start  your  branding 
process again. Don't let imperfections with logo design or branding stop you from moving forward. 
I made that mistake once and it slowed me down for weeks. If your struggling just keep it really 
simple and plain then move on.

Now lets do some more work to your site. 
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